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Welcome 

The SportEvac training system has been designed for your venue managers, incident command team, and first 

responders to enhance their ability to plan, train, and prepare for events such as spectator sports and other mass 

gatherings utilizing “what-if” scenarios. SportEvac contains a three dimensional (3D) and two dimensional (2D) 

model of a mid-size, collegiate style stadium called Stadium USA. Within this modeled environment, users can 

simulate various types of evacuation scenarios and simultaneously inject conditions and constraints as the 

simulated evacuations are executed. 

 

This training system can be used for: 

 

EVENT PREPARDNESS AND PLANNING 
 

 Allocating and manage personnel and physical resources in and around a venue 
 Aid in enhancing and developing plans (evacuation, crisis communication etc.) 

 Importing existing emergency plans, procedures etc. 

 Clarifying unified roles and responsibilities 

 Conducting sport stadium, arena and track evacuation and other emergency plan    analyses 

 Enhancing interagency coordination and communication 
 

TRAINING 

 
Train responders for weather, fan violence, acts of terrorism, crowd control, accidents and IED attacks. 

Utilize SportEvac for seminars, workshops, table top exercises and games to train incident command team, 

supervisors, line staff, etc. 
 

 Create and respond to “what-if” scenarios 

 Execute evacuation simulations 
 Train personnel specifically for IED attacks utilizing the enclosed Electronic Bomb       Card 

 
RESPONSE AND IMPROVEMENT 

 Review potential sport safety and security gaps in resources; and 
 Identify opportunities for safety and security improvement 
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User Interface 

 

 

 

SportEvac consist of five main windows to support decision making and scenario operations. The Main windows 

are the 3D View accompanied by the Resource Panel, the Map View accompanied by the Map Layers Window, and 

the Control Panel window. 

 3D View (top-center window): The 3D environment of Stadium USA; allows for visualization of assets and 

simulated events 

 Resource Panel (left window): A editable list of assets and updated resources as they are added/deleted 

from the 3D view 

 Map View (bottom-center window): 2D GIS map of the infrastructure around Stadium USA; allows the 

user to see assets placed in the 3D view, identify possible evacuation routes, measure distances and 

areas, and identify critical infrastructure in the area. 

Note: The 2D GIS map is only available with a valid ESRI ArcGIS license installed! Without this license the 

Map View panel is grayed and will not display the infrastructure around Stadium USA. 

 Map Layers Window (center right): A tool where individual map layers can be turned on and off 

 Control Panel (bottom window): Allows user to interact with simulated aspects of the simulation, e.g. 

closing/opening portals or doors 

Note: All windows may be closed via the small x in the upper right corner of each window 
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3D View Navigation 

Navigation in the 3D View can be accomplished with mouse and keyboard. 

Mouse Commands 

Left Mouse Button Pans the view 

Right Mouse Button Pivots the view 

Left and Right Mouse Button Forward and backward movement 

Left Mouse Button and Scroll Wheel  Adjusts the yaw 

Scroll Wheel 2D view zoom 

 

Key Board Commands     

W Movement Forward 

A Left 

S Movement Backward 

D Right 

Z Movement up along the Z-axis 

X,C Movement down along the Z-axis 

  

Arrow Key Up Pivot Up 

Arrow Key Down Pivot Down 

Arrow Key Left Pivot  Left 

Arrow Key Right Pivot Right 

  

Space Bar Toggles the ability to control the view using keyboard shortcuts 

  

Ctrl + selected resource + mouse  User can move selected resource be moving the mouse left, right, up 

and down 

Ctrl + Shift  + selected resource  + 

mouse 

User can move selected resource vertically by moving the mouse up 

and down 
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Menu Ribbon 

The menu ribbon located at the top of the user interface contains several tabs. Home, View, Selection, Simulate, 

Results, Tools and Help tabs offer various tools to aid the user. 

Home 

 

The Home tab allows the user to open and save a model. Here, they can also save the availability of passageways 

and portals, and reopen that particular configuration. Finally, the user can close the application from the Home 

menu. 

File 

 Open Model: Dialogue to open 3D models 

 Save: Allows the user to overwrite the current model with updated resources, such as the placement of 

IDEs or resources. 

 Save As: Allows the user to save a new model with updated resources, thus also keeping the old one 

unchanged. 

Settings 

 Load: Allows for the use of previously generated settings. 

 Save: Allows the user to save current settings. If settings have not been loaded, prompts the user to 

create a new settings file. 

 Save As: Allows the user to create new settings file. 

Quit 

 Close Application: Will close SportEvac and exit the application. 
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View 

 

The View tab allows the user to manipulate what is seen on screen. This includes the enabling and disabling the 

panels as well as viewing predefined camera views. It also allows the user to add their own customized camera 

views. 

Layout 

 2D: Displays top down 2D view of Stadium USA, similar to architecture illustrations. 

 3D: Displays a 3D view of the Stadium USA model. (Default) 

Toolbars 

 Layers: Displays Height Layer visibility tools for 2D and 3D model views. The Layers tool is displayed on 

the right side of the 2D or 3D model view. This will allow the user to focus visibility on a single portion of 

the model. To display only one layer, select the layer’s name in the list then press “Show active”. To 

display all again, press “Show all”.  

 Control Panel: Displays the Control Panel. The control panel is used to view the status of 

passageways/portals and to change their direction. 

 GIS: Displays GIS map. 

 GIS Layers: Displays GIS Layers control. This allows the user to control what GIS resources are illustrated 

on the GIS map. 

 GIS Toolbar: Displays GIS functionality tools. 

 Resources: Displays the Resources panel. The Resources panel allows the user to place specific resources 

and/or IEDs to the model.  

 Close Panels: This option will close all panels except 3D view. 

Cameras  

 Camera Position: A tool to rapidly select predefined list of various camera views. 

 Edit Positions: Allows for the editing of existing views and creation of new views. 

Note: When adding/editing a camera view, the model must be saved for those views to exist the next time the 

model is opened. 
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Selection 

 

The Selection Tab provides tools to manipulate resources in the 3D environment. 

Edit 

 Undo: Undoes the moving of a resource 

 Redo: Redoes the moving of a resource 

 Delete: Removes selected resource from 3D view as well as from Resources tree. 

Position 

 Move: Provides tool to change the location of a resource to a specific XYZ coordinate. 

 Rotate: Provides tool to rotate the direction of the currently selected resource. 

 

Simulate 

 

The Simulate tab provides all of the necessary controls to select and run a simulation, edit seating fill rates, and 

run experiments. 

Run Control 

 Reset: Stops and resets the running simulation. 

 Run: Starts the simulation based on the currently selected scenario or continues an already involved 

simulation. 

 Stop: Pauses the currently running simulation. 

 Step: Pauses a running simulation and executes the next step. 
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Run Speed 

The speed of the simulation is based on the number of seconds of simulation time executed in one real time 

second. The user can edit the run speed in two ways: 

 Change Speed: Drag bar to increase or decrease speed of the simulation. 

 Edit Speed: Directly enter numerical value of desired simulation speed. 

Note: The simulation will only run as fast as the hardware allows it. The simulation may never reach the ratio that 

was set. 

Settings 

 Scenario Selection: Select from predefined scenarios. All scenarios are completed according to the fill 

rates. 

o Ingress – An empty stadium is. People enter and sit. 

o Egress – A full stadium is emptied. Depending on where they are seated, spectators head for 

specific exits.  

o Evacuation – A full stadium is emptied. Spectators exit through the fastest route 

o Fill Stadium –A stadium is immediately filled. 

o Fire Partial – A full stadium evacuates according to a fire route. 

 Visitor Settings: Brings up a tool to view current stand statistics and to edit seating capacity per section 

of the stadium.  On the right is a table with various data points. Fill Rate (%) can be edited by using the 

Fill Rate update button on the right.  

o Name: Name of stand section 

o Capacity: Total capacity available.  

o Current #: Current total of agents seated in the section  

o Full (%): Percentage of total capacity 

o Fill Rate (%): Percentage of total capacity to be utilized. 

o Fill Rate Update: Offers a field where the user can input a new Fill Rate for the currently selected 

stand section. 

o Sorting: This will sort the table based on selected criteria, e.g. Name, Capacity, Current #. 
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Experiment 

An experiment is simply a simulation whose output has been saved 

and can be analyzed and replayed. To start an experiment, press 

the “Wizard” button. Fill out the fields and then press Start. 

 Name: The name of the experiment. 

 Directory: Where the results will be stored. 

 Description: A short description of the current experiment. 

 Run length: How long the simulation should run in seconds. 

1200 seconds is 20 minutes. 

 Num of Reps: How many times the experiment will run. This 

is useful as each repetition will be different. 

The simulation will then begin and be saved. You can then import 

that data and analyze it in the Results tab. 
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Results 

 

The Results tab allows the user to interact with and analyze data generated by the Experiment Wizard. From this 

tab, users can generate reports that contain average walking times of agents and view density maps from the 

simulation. This data can be printed or exported to PDF for use later. 

File 

 Open Results: Loads the data folder from the Experiment. Also creates a new Result Player menu. 

 Close Results: Closes any open experiment results. 

General 

 General Statistics: Displays basic information about the experiment such as the scenario name, the run 

date, agent totals, number of agents per location, number of agents travelling from one location to 

another, and travel times. 

 Report: Generates a cohesive report from various analytic tools. This is discussed more thoroughly later. 

Graphs 

 Walking times: Allows the user to generate graphs that show the number of agents walking along a 

particular route over time. 

Color Maps 

These place a layer on top of the model that shows various data. 

 Density: Shows how tightly the agents were packed together over the course of the simulation. 

 Frequency: Shows how often a particular path was taken, how many footprints walked on that spot. 

 Walking Times: Shows how long it took each agent to exit the model. 

 Clear: Removes any of the above layers. 

Note: For more detailed information about the Results, see the “Analysis of Results” section. 

  



 

SportEvac User Guide   Page 12 of 29 
 

Tools 

 

Record Movie 

SportEvac allows the user to record a movie of the simulation.  

 Setup – Allows the user to set the frames per second, the frame interval, and the location where the 

recording will be stored. 

 Start/Pause – Starts and pauses the recording. When recording, the top of the window will turn red. 

When paused, it will turn a light blue.  

 Stop – Stops the recording and stores the film.  

Note: If there was a simulation running when the recording is stopped, the simulation will also be stopped. 

Continue it by pressing Run in the View menu. 

 

Help 

 

The Help tab contains useful documentation and links about SportEvac. 

 Help: Pedestrian Dynamic’s Help. 

 Tutorial: Pedestrian Dynamic’s Tutorial. 

 E-Bomb: Launches the Electronic Bomb Card program in a separate window. 

 About: Pop-up with useful information about the installation of SportEvac 

 SportEvac Website: Launches browser window to http://www.sportevac.com/ which redirects to 

http://www.stadiumsimulation.com  
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3D Resources 

 

The Resources panel allows the user the option to add individual resources, fly-to the resource from anywhere in 

SportEvac, and edit the resource’s attributes. 

 

Adding Resources 

Available resources are separated into groups such as “Fire” and “E-Bomb”. Pressing the “+” next to the type of 

group will cause more specific resource types to appear. To add the resource to the model, simply select the 

specific resource and drag it onto the 3D window.  

When adding a resource, a 3D representation of the resource is placed into the model. An icon will also be added 

to the map view. 

Note: It is not possible to add generic resource types to the model. 
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Viewing/“Flying-to” Resources 

SportEvac 2 allows a user to quickly find and view placed resources. Begin by selecting the resource in the 

resource list. Next, press the “Fly-to” button. The camera will then “fly” you to the placed resource. If you 

wish to immediately view it, you may instead push the  “View” button. 

Editing Placed Resources 

To edit a resource’s attributes, such as name, group, assignment, section, etc., first select the object. You can do 

this by clicking on the resource which will then become highlighted. An example of an unselected (left) and 

selected (right) Bomb Technician is shown below. 

 

Then double-click on the resource. The resource attributes window will now appear. After making the changes you 

want, press “Ok”.  
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You can also edit resources from the resource menu itself. After adding resources, you’ll see another “+” appear 

next to the specific resource types. By clicking the “+”, you’ll be able to see a list of all that have been added of 

that type. You can then select the added resource and press the  “Edit” button. 

 

Moving Resources 

To move a resource, first select the item by clicking on it in the model. To move the object along its X-Y axis, hold 

the “Ctrl” key down while dragging the item. Release both mouse and key when finished. To move the object 

vertically, repeat the above but also hold the “Shift” key. 

Removing Resources 

To remove a resource from the model, first select the resource you wish to remove. You may do this from either 

the model or the resource list. Then, press the Delete key on your keyboard. 
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Analysis of Results 

In this section, we’ll detail how to use the analysis tools found in the Results tab. 

Note: To use any of these tools, you must first run an experiment and then load the results into SportEvac. See the 

appropriate sections earlier for more information. 

Walking times 

 

Walking times displays a graph of the time it took for agents to leave one location and go to another. Above, we 

see how long it took all agents to leave their seats in the stands and exit. This can be drilled down to a specific 

stand to the any exit or any stand to a particular exit or any combination therein. 

 

 

 

 

 

 

Nr Agents: 10045

Mean: 2:22

SD: 1:21

Min: 0:17

Max: 13:21

StandsToExit

<= Travel time (min:sec)

0:30 2:00 3:30 5:00 6:30 8:00 9:30 11:00 12:30

N
r 

o
f 

a
g

e
n

ts

1,800

1,600

1,400

1,200

1,000

800

600

400

200

0

C
u

m
. to

ta
l (%

)

100%

90%

80%

70%

60%

50%

40%

30%

20%

10%



 

SportEvac User Guide   Page 17 of 29 
 

When you first open the dialog, you’ll see a window like the one below. 

 

You’ll see that there’s a predefined route already added. If you click “Show Graph” at the bottom of the window, 

you’ll see an empty graph. We’ll explain why shortly. 

By clicking on the “Edit” button, you’ll bring up a dialog the edit the route’s settings. You’ll see a place for a 

name, the interval length, and the max number of intervals for this particular graph. You can edit or leave the 

defaults as is, but depending on the activities you’re analyzing choosing a better name might be wise. 

The meat of this window is the next section where you can add and edit the routes. There are eight different types 

of activity locations built into SportEvac, but only two are currently utilized: “Entry_Exit” and “Stands”. These are 

the only two activities worth using. 

If we skip down the Resulting Activity list, we’ll see two activities already placed. You can think of these as a list 

of activities that the agent will do in order over the course of the simulation. In this case, we’re looking for agents 

that enter and then exit. However, there is no scenario that calls for the agents to enter and then exit; they either 

enter and go to their seats or leave their seats and exit. For this reason, the empty graph is shown as there are no 

agents that match this set of activities. 
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In order to get some actual graphs generated, we’ll need to set the list to one that will match some of the agents. 

If you have an entering scenario’s results loaded (i.e., INGRESS), select the bottom of the two. If you have an 

exiting scenario’s results loaded (EGRESS, EVACUATION, or FIREPARTIAL), select the top. Now, select “Stands” 

from the above activity type list. When you do so, the next two dropdowns change. 

 

You can either select a particular group or keep “***ALL***” selected. In the next one, you’re able to select a 

particular stand or all as well. After making your choices, click the “Update” button to the right. Then click 

“Apply” at the bottom. 

The graph has now been added, and you can view it by pressing “Show Graph”. To add more graphs, click the 

“Add” button and follow the above steps. You can add an unlimited amount of graphs. 

Color Maps 

 

Depending on the map selected, color maps can be used to visualize agent traffic. Density maps can be used to 

see how compressed agents are while frequency maps display how much a path is used. 

Note: Unless the user is wishing to look at the stadium as a whole, it’s advantageous to analyze one layer at a 

time.  
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Density Maps 

Begin by choosing the layer you wish to analyze. Using the “Layers” toolbar under the “View” menu, show only it. 

Remember the name of the layer. Under the “Results” toolbar, select the  “Density” button. The Density select 

dialog appears. 

 

In the dropdown, select the layer you selected earlier and press “Calculate”. SportEvac will determine the density 

of agents and visualize it. 

Frequency Maps 

The steps to generate a Frequency Map are similar to those of the Density Map. With a frequency map, you can 

choose to rescale the values based on a linear or logarithmic scale. 
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Report 

Report Settings 

All of the analysis tools culminate together into one cohesive document: the Report. The Report contains all of the 

data from “General Settings”, all the graphs created in “Walking Times”, and any screenshots you create. Of 

course, you can elect to include any and all of these. 

Note: If you are going to include “Walking Times” graphs, create those first. Then return here. 

To begin, press the  “Report” button in the “Results” menu. You’ll see the “Report Settings” dialog box 

appear. 

 

Some default settings are already set. You can change these to fit your needs. We recommend you change the 

Orientation to “Landscape” and set the Paper size to “Letter”. 

Many of the tabs here do not require editing as they’re either generated automatically or created elsewhere; you 

can safely ignore the “Tables” and “Charts” tabs. Instead, we’ll begin in the Screenshots tab. 
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Screenshots 

First make sure that all layers are shown. See the “View” section under the “Menu Ribbon” of this manual. Next, 

generate a color map with the layers set to “0: All Layers”. Now position the 2D or 3D view to the location you 

wish to take a screenshot of. After doing so, reopen the “Report settings” dialog box by clicking “Report” on the 

“Results” menu and navigate to the “Screenshots” tab. 

Depending on the type of view you have open, click either “Add 2D view” or “Add 3D view”. A new row will appear 

in the list and a few options above will become available for editing. 

 

Note: Because this is a 3D view, we selected the “Add 3D view” button. If we had clicked the “Add 2D view” 

button, we would get an error saying “No 2D layout open or selected.” 

We’ll now add a caption and select “DensityMap” for the “Output:” box because that’s the kind of color map we 

generated. Where it says “Select height layer”, we’ll select “0: All Layers”. Click “Apply” at the bottom of the 

window. 
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We can continue adding as many screenshots as we like this way.  

Generating the Report 

Once we are ready to generate the report, we make sure the “Report” tab is selected then press the “Show report” 

button. A series of windows and progress bars will appear before the final report window is displayed. From here, 

you can view, save, and print the generated report.  

Note: Pressing “Ok” or “Apply” on the “Report settings” window will not generate a report but rather save these 

settings to be used later. 
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Map Tools 

Users can pan back and forth using the hand icon located on the Map Viewer Toolbar and zoom in and out of 

different map views using the + and - icons. Additionally, users can zoom in and out by using the mouse scroll 

wheel. 

 

The forward and backward buttons will return to and from different views of the Map Viewer. 

Feature Information Tool: This tool provides detailed information about specific map features. Below is an 

example of such information. 

 

 

 

Map screen Identify Tool:                  The Identify tool allows the user to identify features on the map and get 

detailed information about buildings, roads and other map features. 

Note: Remember to choose the group you want to identify. The map will select the topmost layer if a group is not 

selected. 

 

Using the “Identify From” drop down 

menu the user can select a specific 

layer group (e.g. local roads) in order 

to view more information about that 

specific map feature. This may be 

useful for identification of critical 

infrastructure such as hospitals and fire 

stations 
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Map Measure Tool:        The Map Measure Tool, denoted by the ruler icon in the Map Viewer tool bar, gives 

the user the ability to measure the distance between chosen points of interest and calculate the area of a chosen 

building, space, property or other map feature. 

 
Note: The line will measure distance and the polygon will measure area.  Units can be displayed in either metric 

or English units. 

 

 ccElectronic Bomb Card 

The Electronic Bomb Card (E-Bomb Card) allows for the placement of improvised explosive devices (IEDs), either 

predefined or user-defined, into the 3D viewer. The IED will also appear in the map viewer as an icon. This tool 

also displays the IED’s radius of effect. 

 

Note: The left panel displays the IED list while the right displays the E-Bomb Card. 
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E-Bomb Card 

The E-Bomb button allows the user to look at the E-Bomb card and the categories of explosive devices and areas 

of effect. This E-bomb menu will give the user an idea of the area of effect 

for typical IED delivery systems. 

To open the E-Bomb Card, navigate to the Help menu and press the   E-

Bomb button. Next, select the type of bomb you’ll wish to review. Each 

option shows what type of bomb you’ll be viewing and TNT weight 

equivalent. From here, you’ll be able to see the charge weight and select what damage area you’ll like to view by 

simply clicking on the damage type. For some, you’ll need to clarify further, e.g. when choosing “Window 

Damage”, you’ll need to specify whether you wish to view the damage to “Small” or “Large” windows. 

 

After choosing one, you’ll see the resultant area of effect. From here you can Print it out in PDF format or Export 

the raw data to XML. 
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Note: If a specific bomb type is chosen, the charge weight is uneditable. To analyze an area of effect for a specific 

charge weight, choose the “USER DEFINED” option and add your weight.  

Adding IEDs to the Model 

Placing an IED is similar to adding a resource and can also be found in the Resources menu. Begin by selecting 

the type of bomb and then drag it onto the model. A 3D representation will appear and an icon will be shown in 

the map viewer.  

Enabling and Editing IEDs 

After placing, you must then enable it by giving it some parameters. Do this by selecting, then double-clicking the 

placed IED. The IED’s settings dialog will appear. Here you’ll be able to name the bomb, set the type of damage 

you wish to be displayed, the charge weight of the bomb, and how you would to visually see the results. You’ll 

notice that some defaults have been filled in. You can either edit them to your liking or simply press “Ok”. After 

doing so, the effects of the bomb are shown in the 3D model and in the map viewer. 

You’re also able to set where you would like to see the area of effect: nowhere, only 2D, only 3D, or both. In 

addition, the user is also able to set the transparency of that area, i.e. how easy it is to see through the radius. 

The defaults should be fine for most users. 
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Note: For the purposes of this example, the type of damage being shown is for skull damage. 

Moving, Viewing, Removing IEDs 

To move, fly-to, or remove IEDs, please follow the instructions from the 3D Resources section. 
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Simulations 

A simulation is a scripted movement of a crowd of people (i.e. agents) based on a pre-defined scenario. 

In order to execute any of the pre-installed Stadium USA simulations, first select the “Simulate” tab. At the 

“Scenario Selection” dropdown box select one of the following scenarios: 

 INGRESS – Standard beginning of game ingress 

 EGRESS – Standard end of game egress 

 EVACUATION – Immediate evacuation of stadium 

 FILLSTADIUM – Not really sure… 

 FIREPARTIAL – Fire partial evacuation 

After selected a simulation, press the Run button. 

Note: If no scenario is selected, SportEvac will run an Ingress simulation. 

At any point during the simulation, you may Reset, Stop, or Step through the scenario or edit the run speed. 

You’re also able to add resources and IEDs during the simulation without stopping.  

Using the Control Panel 

The Control Panel is the largest innovation in SportEvac. Here, a user can open and close passageways and 

portals in real time. This will allow the user to better understand the effects of the decisions they make.  

 

Within the Control Panel there is a list of each passageway and portal in the model. Their current direction, their 

new set direction, name, layer, and (if applicable) what group of passageways they belong to. The user can sort 

via all of these attributes. Also, these can be filtered out to only display those on a certain layer or set to a certain 

direction. 

To use the Control Panel, simply find and select the passageway/portal you wish to edit. You can also select 

groups by selecting one, holding the mouse button down, and dragging to highlight each one you wish to edit. 

Then push the button representing the new direction and hit the checkbox. 

If the simulation is running when you’re doing this, expect it to pause while it updates. This pause may last 4-5 

seconds before continuing. The agents will then begin to adjust themselves according to your changes, e.g. if a 

door they were going to walk through is now closed, they’ll find another route to their destination.  
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Settings 

SportEvac allows the user to store various data in an external xml file that can easily be reloaded. This allows the 

user to have various situations that will impact how the simulation is run. The following types of data are able to 

be stored and retrieved: 

 Passageway and Portal directions 

 Placed resources including their attributes such as name, group assignment, etc. 

 Placed IEDs 

 The fill rates from the Visitor Settings menu 

To do this, simply make the changes you wish. Then press the  “Save Settings” button. If you haven’t already 

loaded a settings file, you may be prompted to specify the location and name of your new settings file.  

 

After doing so, you can make more changes and then press the  “Save Settings” button again to save those 

changes to that same file. To save it to a different file, press the  “Save Settings As” button.  

Now at any time you wish to load those changes, you can press the  “Load Settings” button and load those 

changes again. 


